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Preface to Third Edition

In going from the previous edition to this third edition, we have made many significant
changes. A new chapter, “Biological Systems: Transport of Heat, Mass, and Electric
Charge,” has been added. To make room for this new material, Chapter 8, “Machine
Design,” of the previous edition has been removed. In Chapter 1, “Introduction,” more
details on the setup of user preferences and the use of the MATLAB editor are provided,
and the number of exercises has been significantly increased. Also, the Symbolic
toolbox has been moved to this chapter. In Chapter 5, “Function Creation and Select-
ed MATLAB Functions,” the section dealing with the differential equation solvers now
includes the delay differential equations solver (dde23) and the one-dimensional
parabolic—elliptic partial differential equations solver (pdepe). In addition, the range
of examples for the ordinary differential equations solver bvp4c has been expanded to
better illustrate its wide applicability. Chapter 6, “2D Graphics,” contains twice the
number of special-purpose graph functions, more material on the enhancement of
graphs, and several new examples replacing those used in the second edition. Chapter
9, “Vibrations,” has been extensively revised and expanded to include a wider range of
applications. Chapter 13 “Optimization,” has also been expanded to demonstrate the
use of the new Genetic Algorithm and Direct Search toolbox.

Overall, the book has been “refreshed” to reflect the authors’ collective
experiences with MATLAB, to introduce the new enhancements that are available
in the MATLAB editor, and to include some of the new functions that have been
introduced since the last edition. Overall, the examples, exercises, and MATLAB
functions presented in the book have been increased by more than 25%. The book
now contains 190 numbered examples, almost 300 exercises, and more than 375
MaATLAB functions that are illustrated. The programs in this edition have been run
on Version 2009a.

NEW TO THE EDITION

e Text was revised and tested throughout for the latest version of the software:
release 2009a

¢ A new chapter has been added: Biological Systems: Transport of Heat, Mass,
and Electric Charge

* 25% increase in number of examples, exercises, and Matlab functions
e Range of applications increased to include biology and electrical engineering

e Chapter 5 Function Creation and Selected Matlab Functions now includes the
delay differential equations solver (dde23) and the one-dimensional parabolic-
elliptic partial differential equations solver (pdepe).

xxi



xXii Preface to Third Edition

¢ Expanded coverage in Chapter 9 Vibrations gives a wider range of applications.

e Chapter 13 Optimization has been expanded to demonstrate the use of the
new Genetic Algorithm and Direct Search toolbox.

We have also created additional resources for the instructor and for the user.
In addition to a solution manual that is available to instructors, we also provide a set
of PowerPoint slides covering the material presented in Chapters 1-7. For the user
of the book, we have created M files of all the numbered examples in each chapter.
These ancillary materials can be accessed from the publisher’s Web site.

E. B. MAGRAB

S. AZARM

B. BALACHANDRAN
J.H. DUNCAN

K. E. HEROLD

G. C. WALSH

College Park, MD
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Edward B. Magrab
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The characteristics of the MATLAB environment and MATLAB’s basic syntax are
introduced.

1.1 INTRODUCTION
MATLAB, which derives its name from Matrix Laboratory, is a computing language
devoted to processing data in the form of arrays of numbers. MATLAB integrates

computation and visualization into a flexible computer environment, and provides

1
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a diverse family of built-in functions that can be used in a straightforward manner to
obtain numerical solutions to a wide range of engineering problems.

1.1.1 Organization of the Book and Its Goals

The primary goal of this book is to enable the reader to generate readable, compact,
and verifiably correct MATLAB programs that obtain numerical solutions to a wide
range of physical and empirical models and display the results with fully annotated
graphics.

The book can be used in several ways:

e To learn MATLAB
e As a companion to engineering texts

¢ As a reference for obtaining numerical solutions to a wide range of engineer-
ing problems

e As a source of applications of a wide variety of MATLAB solution techniques

The level of the book assumes that one has some fluency in calculus, linear
algebra, and engineering mathematics, can employ the engineering approach to
problem solving, and has some experience in using mathematical models to predict
the response of elements, devices, and systems. These qualities play an important
role in creating programs that function correctly.

The book has two interrelated parts. The first part consists of Chapters 1-7, which
introduces the fundamentals of MATLAB syntax and commands and structured
programming techniques. The second part, consisting of Chapters 8-14, makes
extensive use of the first seven chapters to obtain numerical solutions to engineering
problems for a wide range of topics. In several of these topical areas, MATLAB
toolboxes are used extensively to minimize programming complexity so that one can
obtain numerical solutions to engineering problems of varying degrees of difficulty. In
particular, we illustrate the use of the Controls toolbox in Chapters 9 and 10, Simulink
in Chapter 10, the Optimization toolbox in Chapter 13, the Statistics toolbox in
Chapter 8, and the Symbolic toolbox in Chapters 1-5 and 9.

1.1.2 Some Suggestions on How to Use MATLAB

Listed below are some suggestions on how to use the MATLAB environment to
effectively create MATLAB programs.

e Write scripts and functions in a text editor and save them as M-files. This will save
time, save the code, and greatly facilitate the debugging process, especially if the
MATLAB Editor is used.

e Use the Help files extensively. This will minimize errors caused by incorrect
syntax and by incorrect or inappropriate application of a MATLAB function.
o Attempt to minimize the number of expressions comprising a program. This
usually leads to a trade-off between readability and compactness, but it can
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encourage the search for MATLAB functions and procedures that can per-
form some of the programming steps faster and more directly.

e When practical, use graphical output as a program is being developed. This
usually shortens the code development process by identifying potential coding
errors and can facilitate the understanding of the physical process being mod-
eled or analyzed.

e Most importantly, verify by independent means that the output from the pro-
gram is correct.

1.1.3 Book Notation Conventions

In order to facilitate the recognition of the significance of variable names and the
origin of numerical values; that is, whether they are input values or output results,
the following font conventions are employed.

Variable/Function Name Font Example

User-created variable Times Roman ExitPressure, a2, sig
MATLARB function Courier cosh(x),pi
MATLAB reserved word Courier for, switch, while
User-created function Times Roman Bold BeamRoots(a, x, k)
Numerical Value Font Example

Provided in program Times Roman 5.672

Output to command window Helvetica 5.672

or to a graphical display

1.2 THE MATLAB ENVIRONMENT

1.2.1 Introduction

When the MATLAB program is launched, four windows appear as shown in
Figure 1.1. The upper right-hand window is the Workspace window, which displays
a list of the variables that the user has currently defined and their properties.
The center window is the MATLAB Command window. The lower right-hand
window is the Command History window, which displays all entries made in the
command window during each session. A session is the interval between the start
of MATLAB and its termination. The time and date appear before each list in this
window to indicate when these entries began being recorded. It is a convenient way
to review past sessions and to recapture previously used commands. The command
histories are maintained until it is cleared using the Clear Command History selec-
tion from the Edit menu. Similar choices exist for the Workspace and for the
Command windows. These latter two clearing operations will be discussed subse-
quently. The left-hand window displays the files in the current directory.

To bring up the MATLAB Editor/Debugger, which provides the preferred
means to create and run programs, one clicks on the white rectangular icon that
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Figure 1.1 MATLAB default windows.

appears under File in the left uppermost corner of the window. This results in the
configuration shown in Figure 1.2. Other windows can be employed and can be
accessed from the View menu. To eliminate any of the windows, simply close it
by clicking on the X in its respective upper right-hand corner. One way to config-
ure these windows is to use only the command window and the editor window and
to call up the other windows when needed. One such configuration of these two
windows is shown in Figure 1.3. Upon restarting MATLAB, the system will
remember this configuration and this arrangement of the windows will appear.
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Figure 1.2 MATLAB default windows and the Editor.
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Figure 1.3 MATLAB command window (left) and the Editor (right) after closing
the command history, current directory, and workspace windows and opening the
Editor.

1.2.2 Preliminaries—Command Window Management

During any MATLARB session—that is, during any time until the program is exited —
MATLAB retains in its memory the most recently obtained values of all variables
defined by each expression that has been either typed in the command window
or evaluated from a script file, unless the clear function is invoked. The clearing
of the variables in the workspace can also be obtained by selecting Clear Workspace
from the Edit pull-down menu, as shown in Figure 1.4. The clear function deletes
all the variables from memory. The numerical values most recently assigned to these
variables are accessible anytime during the session (provided that clear hasn’t been
used) by simply typing the variable’s name or by using it in an expression.

Typing performed in the MATLAB command window remains in the window
and can be accessed by scrolling back until the scrolling memory has been exceeded,
at which point the earliest entered information has been lost. However, the expres-
sions evaluated from the execution of a script file are not available in the command
window, although the variable names and their numerical values are available as
indicated in the preceding paragraph. This record of previously typed expressions in
the command window can be removed by going to the Edit pull-down menu at the
top of the MATLAB command window and selecting Clear Command Window,
which clears the MATLAB command window, but does not delete the variables,
which have to be removed by using clear. Refer to Figure 1.4. One could also clear
the command window by typing c1lc in the command window. In addition, the copy
and paste icons can be used either to reproduce previously typed expressions in the
current (active) line in the MATLAB command window or to paste MATLAB
expressions from the MATLAB command window into the Editor or vice versa.
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Figure 1.4 Edit pull-down menu selections.

For a listing of what variables have been created since the last application of
clear, one either types whos in the MATLAB command window or goes to the
pull-down View menu and selects Workspace, which opens a window with this infor-
mation. Either method reveals the names of the variables, their size, the number of
bytes of storage that each variable uses, and their class: double (8 byte numerical
value), which is discussed in Chapter 2; string (literal), which is discussed in Section
3.1; symbolic, which is discussed in Section 1.4; cell, which is discussed in Section 3.4;
or function, which is discussed in Section 5.2. The Workspace window can be
unlocked from its default location by clicking on the icon next to the X in its upper
right-hand corner. When one is done with the window, it can be minimized so that
this information is readily available for the next time. To make the numbers that
appear in the command window more readable, MATLAB offers several options
with the format function. Two functions that are particularly useful are

format compact
and
format long e

The former removes empty (blank) lines and the latter provides a toggle from the
default format of 5 digits to a format with 16 digits plus a 3-digit exponent. The format
long e option is useful when debugging scripts that produce numbers that either
change by very small amounts or vary over a wide range. To toggle back to the default
settings, one types the command

format short
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These attributes can also be changed by selecting Preferences from the File pull-
down menu and selecting Command Window as shown in Figure 1.5. The changes
are then made by selecting the desired format from the list of available formats. The
different formats that are available are listed in Table 1.1.

Two keyboard entries that are very useful are "¢ (Ctrl and ¢ simultaneously)
and "p (Ctrl and p simultaneously). Application of "p places in the MATLAB

TABLE 1.1 Examples of the Command Window format Options

Option Display number > 1 Display 0 < number < 1
short 444 .4444 0.0044

long 4.4444444444444456+002 0.004444444444444
short e 4.4444e+002 4.4444e-003

long e 4.4444444444444456+002 4.4444444444444446-003
short g 444.44 0.0044444

long g 444.444444444444 0.00444444444444444
short eng 444.4444e+000 4.4444e-003

long eng 444.4444444444446+000 4.444444444444446-003
rational 4000/9 1/225

hex 407bc71c71c71c72 3f723456789abcdf

bank 444.44 0.00
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command window the last entry typed from the keyboard, which can then be imple-
mented by pressing Enter. In addition, prior to pressing Enter, one can modify the
expression. If Enter is not pressed and instead "p is entered again, then the next
most recently typed entry replaces the most recent entry, and so on. This same result
can be obtained using the up-arrow (1) and down-arrow (l) keys. The application
of "¢ either aborts a running program or exits a paused program.

1.2.3 Executing Expressions from the MATLAB
Command Window—Basic MATLAB Syntax

MATLAB permits the user to create variable names with a length of up to sixty-
three alphanumeric characters, with the characters after the sixty-third being
ignored. Each variable name must start with either an uppercase or lowercase letter,
which can then be followed by any combination of uppercase and lowercase letters,
numbers, and the underscore character (_). No blank spaces may appear between
these characters. Variable names are case sensitive, so a variable named junk is dif-
ferent from junK. There are two commonly used conventions: one that uses the
underscore and the other that uses capital letters. For example, if the exit pressure is
a quantity that is being evaluated, then two possible definitions that could be
defined in a MATLAB command line, script, or function are exit_pressure and
ExitPressure. There are, however, several variable names called keywords that are
explicitly reserved for MATLAB as part of its programming language. These key-
words, which are listed in Table 1.2, may never be used as variable names. The usage
of most of these keywords will be given in the subsequent chapters.

Creating suitable variable names is a trade-off between easily recognizable
and descriptive identifiers and readability of the resulting expressions. If the expres-
sion has many variable names, then short variable names are preferable. This
becomes increasingly important as the grouping of the symbols becomes more com-
plex. Shorter names tend to decrease errors caused by the improper grouping of
terms and the placement of arithmetic operators. In addition, one can neither use
Greek letters literally as variable names nor can one use subscripts and superscripts.
However, one can spell the Greek letter or can simply precede the subscript by the
underscore character. For example, one could represent o, as sigma_r and c3 as ¢3
or c_3.

TABLE 1.2 Keywords Reserved Explicitly for the
MATLAB Programming Language

break global
case if

catch otherwise
continue persistent
else return
elseif switch

end try

for while

function
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We shall illustrate the two ways in which one can evaluate expressions in
MATLAB: one from the command window and the other from the Editor. When
using the command window, one must define one or more variables at the prompt
(>>). MATLAB requires that all variables, except those defined as symbolic quan-
tities and used by the Symbolic toolbox, be assigned numerical values prior to being
used in an expression. The assignment operator is the equal sign (=). Typing the
variable name, an equal sign, the numerical value(s), and then Enter performs the
assignment. Thus, if we wish to assign three variables p, x, and k the values 7.1,4.92,
and —1.7, respectively, then the following interaction in the MATLAB command
window is obtained.

»p=7.1 ~«— User types and hits Enter
p =

7 1000 :| ~«—— System response
»x=4.92 —<€— User types and hits Enter
X =

4.9200
»k=-1.7  —€— User types and hits Enter
k=

-1.7000

:| <«— System response

:| <«— System response

This command window interaction was obtained using format compact.

In order to suppress the system’s response, one places a semicolon (;) as the
last character of the expression. Thus, typing each of the following three expressions
on their respective lines followed by Enter, gives

» p=7.1;
» X=4.92;
» k=-1.7,

»

MATLAB also lets one place several expressions on one line, a line being
terminated by Enter. In this case, each expression is separated by either a comma (,)
or a semicolon (;). When a comma is used, the system echoes the input. Thus, if the
following is typed,

p=71,x=492 k=-17
then the system responds with

p=
7.1000

X =
4.9200

k=
-1.7000

»

The use of semicolons instead of the commas would have suppressed this output.
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Arithmetic Operators

The five arithmetic operators to perform addition, subtraction, multiplication, division,
and exponentiation are +, —, *, /, and ", respectively. For example, the mathematical

expression
1 k
= (5)
1+ px

t = (1/(1+p*x))"k

when p, x, and k are scalar quantities. The quantities p, x, and k must be assigned
numerical values prior to the execution of this statement. If this has not been done,
then an error message to that effect will appear. Assuming that the quantities p, x,
and k were those entered previously in the command window and not cleared, the
system returns

can be written in MATLAB as

t=
440.8779

Mathematical Operations Hierarchy

The parentheses in the MATLAB expression for ¢ have to be used so that the mathe-
matical operations are performed on the proper collections of quantities in their prop-
er order within each set of parentheses. There is a hierarchy and a specific order that
MATLAB uses to compute arithmetic statements. One can take advantage of this to
minimize the number of parentheses. However, parentheses that are unnecessary from
MATLAB’s point of view can still be used to remove visual ambiguity and to make the
expression easier to understand. The parentheses are the highest level in the hierarchy,
followed by exponentiation,! then by multiplication and division, and finally by addi-
tion and subtraction. Within each set of parentheses and within each level of hierarchy,
MATLAB performs its operations from left to right. Consider the examples shown in
Table 1.3 involving the scalar quantities ¢, d, g, and x. The MATLAB function

sgrt (x)

takes the square root of its argument x. Notice that in the first row of Table 1.3 the
parentheses around the quantity x + 2 are required. If they weren’t used; that is, the
relation was written as

1-d*c x+2

then, we would have coded the expression 1 — dc* + 2. The same reasoning is true
for the exponent in the third row of the table. In the third row, notice that the form

2%cA(x+2)/d

! The matrix transpose, which is discussed in Section 2.2, is also on the same level as exponentiation. The
matrix transpose symbol in MATLAB is the apostrophe ().
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TABLE 1.3 Examples of MATLAB Syntax: All Quantities Are Scalars

Mathematical expression MATLAB expression

1 — dc*? 1—d#*c\(x+2)

dc* + 2 d#c"x+2 or 2+d*c"x

(2/d)c**? (2/d)*c\(x+2) or 2/d*c\(x+2) or 2*%c"\(x+2)/d
(dc* + 2)/g*7 (d*c"x+2)/g"2.7

Vdc + 2 sart(d*c"x+2) or (d*c"x+2)"0.5

is correct because of the hierarchy rules. The innermost set of parenthesis is (x + 2)
and is computed first. Then, exponentiation is performed, because this is the next
highest level of the computational order. Next, the multiplications and divisions are
performed from left to right, because the three quantities, 2, the result of &2 and d
are all on the same hierarchical level: multiplication and division.

1.2.4 Clarification and Exceptions to MATLAB’s Syntax
Scalars versus Arrays

MATLAB considers all variables as arrays of numbers; therefore, when using the
five arithmetic operators (+,—, *,/,and "), these operations have to obey the rules of
linear algebra. These rules are discussed in Section 2.6. When the variables are scalar
quantities, that is, when they are arrays of one element (one row and one column),
the usual rules of algebra apply. However, one can operate on arrays of numbers
and suspend the rules of linear algebra by using dot operations, which are discussed
in Section 2.5. Dot operations provide a means of performing a sequence of arith-
metic operations on arrays of the same size on an array element by array element
basis. When using the dot operators, the multiplication, division, and exponentiation
operators become .*, ./, and .", respectively.

Blanks

In an arithmetic expression, the use of blanks can be employed with no conse-
quence. Variable names on the right-hand side of the equal sign must be separated
by one of the five arithmetic operators, a comma (,), or a semicolon (;).

There are two exceptions to this usage of blanks. The first is when one repre-
sents a complex number z = a + jb or z = a + ib, where i = j = \/—1. Consider the
following script

a=2;b=3;
z=a+13*%b % or a+b*17

which upon execution gives

Z=
2.0000 + 3.0000i

The number 1 that precedes the j is not required, but it is strongly recommended
by MATLAB that it be used for increased speed and robustness. Notice that the
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program used j, but the system responded with an i, showing the system’s equiva-
lent treatment of these two quantities. Also, note that j was not defined previously;
therefore, MATLAB assumes that it is equal to \/—1. However, when a and b are
replaced with numerical values directly in the expression, no arithmetic operator is
required. Thus, the script

a=2;b=3;
z=(a+13*b)*(4-73)

upon execution gives
z =29.0000 — 2.0000i

In this usage, the j (or i) must follow the number without a space.
The second exception is when we express a number in exponential form such
asx = 4.56 X 1072 This number can be expressed as either

x = 0.0456
or

x =4.56%10"-2
or as

x =4.56e-2

The last expression is the exponential form. Notice that no arithmetic operator is
placed between the last digit of the magnitude and the ‘e’. The maximum number of
digits that can follow the ‘e’ is 3. Thus, if we desired the quantity x*> and we used the
exponential form, the script would be

x2 = 4.56e-2"2
which upon execution displays to the command window

X2 =
0.0021

If the value of x were 4.56 X 107, the implied ‘+’ sign may be omitted; that is,
the square of x can be written as either

x =4.56e2"2
or

X = 4.56e+2"2

System Assignment of Variable Names

When the command window is used as a calculator and no assignment of the expres-
sion has been made, MATLAB will always assign the answer to the variable named
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ans. For example, let us assume that one wants to determine the value of the cosine
of /3. We simply type in the command window?

cos(pi/3)
and the system will respond with

ans =
0.5000

The variable ans can now be used as one would use any other variable name. If
we now want to add 2 to the previous result, then we would type in the command
window

ans+2
and the system would respond with

ans =
2.5000

Thus, ans has been assigned the new value of 2.5. The previous value of ans (= 0.5)

is no longer available.

Complex Numbers

MATLAB permits one to mix real and complex numbers without any special oper-
ation on the part of the user. Thus, if one types in the command window

z=4+ sqrt(-4)
then the system would display

Z=
4.0000 + 2.0000i

As another example, consider the evaluation of the expression ', which is obtained
by typing in the command window

z=1"1
The execution of this expression gives

Z=
0.2079

since i = (e™?)! = ¢ ™ = 0.2079.

2 In the command window, the alphanumeric characters will appear in the same font. We are using differ-
ent fonts to enhance the readability of the expressions as mentioned in Section 1.1.3.
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TABLE 1.4 Some Elementary MATLAB Functions

Mathematical function

MATLAB expression

Introduction

e exp(X)

et — 1 x<<1 expml (X)

Vx sqrt(x)?

In(x) or log,(x) log(x)®
logo(x) logl0(x)

x abs(x)
signum/(x) sign(x)
log,(1+x) x<<l1 loglp(x)

n! factorial(n)®
All prime numbers = n primes(n)

2 If x is an array with each element in the array > 0, use
realsqrt(x) to increase computational speed.

" If x is an array with each element in the array > 0, use
reallog(x) to increase computational speed.

©15 digits accuracy for n = 21;for larger n, only the
magnitude and the 15 most significant digits will be correct.

1.2.5 MATLAB Functions

MATLAB provides a large set of elementary functions and specialized mathemati-
cal functions. Some of the elementary functions and some built-in constants are list-
ed in Tables 1.4, 1.5, and 1.6. In Tables 1.4 and 1.5, x can be a real or complex scalar,
a vector, or a matrix; the quantity # is a real positive integer. The definitions of vec-
tors and matrices and their creation in MATLAB are given in Sections 2.3 and 2.4.
In Table 1.7, we have listed the relational operators that are used in MATLAB.

Several MATLAB functions are available to round decimal numbers to the
nearest integer value using different rounding criteria. These functions are fix,
round, ceil, and floor. The results of the different operations performed by
these four functions are summarized in Table 1.8.

TABLE 1.5 MATLAB Trigonometric and Hyperbolic Functions

Trigonometric Hyperbolic

Function (x in radians) (x in degrees) Inverse Inverse

sine sin(x) sind(x) asin (x) sinh (x) asinh (x)
cosine cos (x) cosd (x) acos (x) cosh (x) acosh (x)
tangent tan (x) tand (x) atan (x) ' tanh (x) atanh (x)
secant sec (x) secd (x) asec (x) sech (x) asech (x)
cosecant csc(x) cscd (x) acsc (x) csch (x) acsch (x)
cotangent cot (x) cotd (x) acot (x) coth (x) acoth (x)

" atan2(y, x) is the four-quadrant version, which must be used when the signs of y and x can each be
positive or negative.
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TABLE 1.6 Some MATLAB Constants and Special Quantities

Mathematical quantity MATLAB

or operation expression Comments

T pi 3.141592653589793

V-1 iorj Used to indicate a complex quantity as
a + 13*b, where a and b are real.

Floating point relative eps The distance from 1.0 to the next largest

accuracy floating-point number (~2.22 X 10719

o inf -

0/0, 0X 00, 0o/co NaN Indicates an undefined mathematical operation.

Largest floating-point number realmax ~1.7977e+308

before overflow

Smallest floating-point number realmin ~2.2251e—308

before underflow

TABLE 1.7 MATLAB Relational Operators

Conditional Mathematical symbol MATLAB symbol

equal

not equal

less than

greater than

less than or equal
greater than or equal

VNV A K
\//”\\//\ll

TABLE 1.8 MATLAB Decimal-to-Integer Conversion Functions

MATLAB function X y Description
2.7 2.0000
y = fix(x) -1.9 —1.0000 Round toward zero
2.49 — 2,515 2.0000 — 2.00001
2.7 3.0000
y = round(x) -1.9 —2.0000 Round to nearest integer
2.49 — 2,517 2.0000 — 3.00001
2.7 3.0000
y = ceil(x) -1.9 —1.0000 Round toward infinity
2.49 — 2,517 3.0000 — 2.00001
2.7 2.0000
y = £loor(x) -19 —2.0000 Round toward minus infinity

2.49 — 2513 2.0000 — 3.00001




16

Chapter 1 Introduction

TABLE 1.9 MATLAB Complex Number Manipulation Functions

MATLAB function z y Description
z = complex(a, b) a+b*j - Form complex number; a and b real
y = abs(z) 3+45 5 Absolute value: Va?> + b?
y = conj(z) 3+45 3—45 Complex conjugate
= real(z) 3+47 3 Real part
= imag(z) 3+45 4 Imaginary part
y = angle(z) a+b*j atan2(b, a) Phase angle in radians: —m<y=m

There are also several MATLAB functions that are used to create and manipu-
late complex numbers. These are complex, abs, conj, real, imag, and angle.The
operations of these six functions are summarized in Table 1.9. Lastly, in Table 1.10, we
have listed several specialized mathematical functions and elementary descriptive sta-
tistical functions. Additional MATLAB functions for various classes of mathematical
operations are given in subsequent chapters. Numerous MATLAB array creation and
manipulation functions are summarized in Table 2.1. MATLAB functions that can

TABLE 1.10 Several Specialized Mathematical Functions and Descriptive Statistical Functions*

Mathematical function

MATLAB Expression

Description

Specialized mathematics

Ai(x), Bi(x)
1,(x)

J,(x)

K, (x)

Y, (x)
B(x,w)
K(m), E(m)

erf(x), erfc(x)
Ey(2)

I'(a)
Pyl(x)

Descriptive Statistics

maximum value of x

o
median

minimum value of x

mode

ogors

0'2 or S2

airy(0,x), airy(2,x)

besseli(nu, x)
besselj(nu, x)
besselk(nu, x)
bessely(nu, x)
beta(x, w)
ellipke(m)

erf(x), erfc(x)

expint(x)
gamma(a)
legendre(n, x)

max(X)
mean(X)
median(x)
min(x)
mode(X)
std(x)
var(x)

Airy functions

Modified Bessel function of first kind
Bessel function of first kind

Modified Bessel function of second kind
Bessel function of second kind

Beta function

Complete elliptic integrals of first and
second kind

Error function and complementary error
function

Exponential integral

Gamma function

Associated Legendre function

Largest element(s) in an array of values
Average or mean value of array of values
Median value of an array of values
Smallest element(s) in an array of values
Most frequent values in an array of values
Standard deviation of an array of values
Variance of an array of values

*See Tables 8.2 and 8.21 for additional statistical functions.
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be used to create and manipulate string expressions (literals) are summarized in
Table 3.1 and those that can be used to analyze data arrays and mathematical expres-
sions are summarized in Table 5.4. Lastly, MATLAB functions that are used to create
2D and 3D graphic displays are summarized in Tables 6.15 and 7.10, respectively.
Specialized functions that are used to model and analyze control systems are summa-
rized in Table 10.1. Functions that deal with optimization of systems are summarized
in Table 13.8, and those that deal with statistics are summarized in Table 8.21. Func-
tions that are used by the Symbolic toolbox are summarized in Table 1.12.

In addition to the five arithmetic operators (+, —, *, /, and ") that were dis-
cussed previously, there are several other symbols that are reserved by MATLAB to
have special meaning. These are listed in Table 1.11 and their usage is discussed in
Chapters 1-5.

TABLE 1.11 Special Characters and a Summary of Their Usage'

Character Name Usage

0

Period (a) Decimal point.
(b) Part of arithmetic operators to indicate a special type of vector
or matrix operation, called the dot operation, such as ¢ =a.*b.
(c) Delimiter in a structure, such as name.first.

Comma (a) Separator within parentheses of matrix elements such as
b(2,7) and functions such as besselj(1, x) or brackets creating
vectors such as v = [1, x] or the output of function arguments
such as [x, s] = max(a).

(b) Placed at the end of an expression when several expressions
appear on one line.

Semicolon (a) Suppresses display of the results when placed at end of an
expression.
(b) Indicates the end of a row in matrix creation statement such
asm = [xyz;abc].

Colon (a) Separator in the vector creation expression x = a:b:c.

(b) For a matrix z, it indicates “all rows” when written as z(:,k) or
“all columns” when written as z(k,:).

Parentheses (a) Denotes subscript of an element of matrix z, where
2(j, k) <> zj is the element in row j and column k.
(b) Delimiters in mathematical expressions such as a’(b+c).
(c) Delimiters for the arguments of functions, such as sin(x).

Brackets Creates an array of numbers, either a vector or a matrix, or an
array of strings (literals).

Braces Creates a cell array.

Percentage Comment delimiter; used to indicate the beginning of a comment

wherein MATLAB ignores everything to its right. The exception
is when it is used inside a pair of single quotes to define a string
such as a="p =14 % of the total'.

(Continued)
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TABLE 1.11 (Continued)

Character Name Usage

% Y% Percentage Used to delimit the start and end of a cell in the MATLAB Edi-
tor, which is a portion of program code.

% { Percentage and Used to enclose a block of contiguous comment lines.

%} brace Comments placed between these delimiters do not have to
be preceded by a %. However, no text can be placed on the
line containing these delimiters.

’ Quote or (a) ‘Expression’ indicates that Expression is a string (literal).

Apostrophe (b) Indicates the transpose of a vector or matrix. If the vector or
matrix is complex, then, in addition, the complex conjugate of
each element is taken.

Ellipsis Continuation of a MATLAB expression to the next line. Used
to create code that is more readable.

Blank Context dependent: either ignored, indicates a delimiter in a data
creation statement such as ¢ = [a b],is a character in a string
statement, or is a delimiter in an optional form of certain
MATLAB functions such as syms a b and format long.

@ At sign Constructs a function handle by placing @ before a function

name, such as @FunctionName.

Backslash (a) A mathematical operator to perform certain matrix operations.
(b) A character that is used to display Greek letters and
mathematical symbols in graph annotation.

See Table 4.1 for a list of logical operators.

Overloading

Although the choice of variable names is virtually unlimited, one should avoid
choosing names that are the same as those used for MATLAB’s built-in functions
or for user-created functions. MATLAB permits one to overload a built-in func-
tion name. For example, the following expression is a valid MATLAB expression

cos = a+b*x"2;

However, since ‘cos’ is also the name used for the cosine function, cos(x), this is a poor
choice for a variable name and it is strongly recommended that such redefinitions be
avoided. An exception to this recommendation is when all quantities in one’s program
are real variables. In this case, overloading i and j will not cause any unexpected results.

Example 1.1 Usage of MATLAB functions

To illustrate the use of the MATLAB’s built-in functions, consider the following expres-
sion to be evaluated at x = 0.1 and a = 0.5:

y = V]e ™ — sinx/ cosha — In,(x + a)
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This expression is evaluated with the following script:
x=0.1; a=0.5;
y = sart(abs(exp(-pi*x)-sin(x)/cosh(a)-log(x+a)))

where the MATLAB function pi = 7. Upon execution, the following result is dis-
played in the command window:

y =
1.0736

1.2.6 Creating Scripts and Executing Them from the MATLAB Editor®

A script file is a file that contains a list of commands, each of which will be operated
on as if it were typed at the command line in the command window. A script file is
created in a word processor, a text editor, or the MATLAB Editor/Debugger, and
saved as a text file with the suffix “.m”. Such files are called M-files. If a word processor
or text editor is used, then the file is executed by typing the file name without the suffix
“.m” in the MATLAB command window. If the MATLAB Editor is used, one can use
the previous method or can click on the Save and Run icon on the top of the Editor’s
window as shown in Figure 1.6. However, before one can use this icon, the file must be
saved the first time by using the Save As option from the File pull-down menu. The file-
naming convention is the same as that for variable names: It must start with an upper
or lower case letter followed by up to sixty-two contiguous alphanumeric characters
and the underscore character. No blank spaces are allowed in file names. (This is differ-
ent from what is allowed by the Windows operating system.) When the MATLAB
Editor/Debugger is used, an “.m” suffix will be affixed to the file name.

Another form of a file created in the Editor is the function file. These functions
are created because one of MATLAB’s built-in functions requires them or one wants
to use them to better manage the programming task. Functions differ from scripts in
that they allow a structured approach to managing the programming task. They differ
from expressions entered at the command line in that MATLAB allots them their
own private workspace and they have formally defined input-output relationships
within the MATLAB environment. Functions are discussed in Chapter 5.

B Editor - Untitled2*

File Edt Text Go Cel Tools Debug Desktop Window Help (A X
NEd| B2 oD Aei (BR-B0RBRE RS el
1 % Save and run iconl u

Save and Run icon |

Figure 1.6  Save and Run (execute) icon in the Editor.

3 In terms of execution time, functions generally run faster than scripts. Functions are introduced in
Chapter 5, where from that point forward, scripts are used less frequently.
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Script files are usually employed in those cases where:

The program will contain more than a few lines of code.

The program will be used a